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Description 

In the early stage of a project, collecting and organizing baseline data is essential and the key to 
the successful result. Satellite, aerial,  or UAV based geospatial data, such as imagery and 
digital elevation model (DEM) , could be one of the most critical foundations of your initial design 
decision, but it’s not always straightforward if you are not familiar with the GIS industry and 
community. 
In this class, I will demonstrate how easy and simple we can import various GIS data into your 
design environment using InfraWorks and Civil 3D. Then I will delve into how it can be done with 
vanilla AutoCAD/AutoCAD LT. 
Several practical techniques to make various GIS data to AutoCAD-readable format will be 
shared. Some GIS concepts, basic terminology, and how to use widely used open-source 
toolset such as GDAL (Geospatial Data Abstraction Library) and QGIS, also related tips & tricks,  
will be explained with Google Earth Pro. 
 
 
 
 
 
 
 

Learning Objectives 

• Reaffirm the strong GIS supports and capabilities in Autodesk’s industry-specific 
products 

• Establish a basic understanding of GIS concept and terminology so that you can 
“google”  info you need on your own 

• Translate GIS data to an AutoCAD native data and open them in AutoCAD model-
space 

• Examine some cases when some GIS data cannot be consumed from Autodesk 
products – and how to resolve them 
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Speakers 

 
Sami (Hisamitsu) Harada is a longtime fan and enthusiast of Autodesk products.  The first 
Autodesk product he encountered was version 2.6 (called “EX2” in the Japanese market) 
running on MS-DOS, then Release 10 (a.k.a. AC1006/GX3) was used while he wrote his master 
thesis. After spending 15 years in several west coast-based US companies, including Autodesk, 
inc., he returned to Tokyo and joined a general incorporated foundation named RESTEC who is 
promoting satellite technology among the general public. One of his current interests is 
democratizing satellite-based geospatial data and lowering the boundary between GIS and CAD 
communities.  
Email: harada_hisamitsu@restec.or.jp 
    Web:     https://www.restec.or.jp/en/ 
    Web:     https://aw3d.jp/en/ 

 
Mariko Morioka has spent more than 10 years in the remote-sensing industry as a sales 
representative. In 2016, she joined Remote Sensing Technology Center of Japan ("RESTEC"), 
promoting satellite technology for 45 years. Her responsibility is to develop and support the 
projects using AW3D, a 3D Map/Digital Elevation Model (DEM) derived from artificial satellite 
imageries for overseas partners and customers. AW3D is a GIS-ready comprehensive data 
including GeoTIFF and DWG/DXF and was used over 130 countries for more than 1,600 
projects, mainly for urban planning, civil engineering, disaster mitigation plan, etc. 
Email: morioka_mariko@restec.or.jp 
    Twitter: @aw3d_sales_team 
    LinkedIn: https://linkedin.com/company/aw3d-global-highresolution-3dmap/ 
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1. GIS 101 – UTM projection 

From time to time, you need to work in 2-dimensional space even you have to deal with 3D 
objects. Working with a 2D drawing/paper map is one of these occasions, and it might not 
straightforward as you can easily imagine. 
GIS data often comes in 3D format since Earth is spherical shape, and you often have to 
transform 3D positions into 2D points – this is why we need a process so-called “projection.” 
Projection, however, comes with tradeoffs in shape, distance, direction and/or size. This means 
that each projection method always has pros and cons, and you have to pick one that works the 
best for your need. 
 

Universal Transverse Mercator (UTM) projection 
 
One of the most frequently used projection is the “Universal Transverse Mercator” (UTM) 
coordinate system. It’s from a relatively simple transformation method, and the result is very 
human friendly. 
See: https://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system 
 
In this class, we will see how we can bring GIS data into 2D DWG using UTM projection. Once 
you know the principle, you can apply the same technique with other “local” coordinate system 
that is suitable for your project. 
 
 

2. Free GIS tools 

Three free GIS Tools used in this class 
 
GIS data comes with various formats with sub/local “dialects”/sub-formats. Because some 
formats are not fully compatible with Autodesk toolsets, you may need to massage data to make 
it readable. In this class, we will see the following free 3 tools that have been popular among 
satellite-based data communities(installation tips can be found in the class video) : 
 

QGIS 
This is the most commonly used open-source GIS GUI tool. Avoid the latest release and 
pick LTR (or try the latest version 2.x) instead if stability is more important than 
experimental new functionality. 
https://qgis.org/en/site/ 
 

GDAL 
This is an X/MIT licensed translator library for raster & vector GIS data. You can bind the 
library in your code, and some command-line tools are also provided.  
https://gdal.org/ 
 

Google Earth Pro 
This a free tool that is extremely popular among the satellite data community. You can 
draw a point/line/polygon on “Earth” and save it as a KML/KMZ file. 

https://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system
https://qgis.org/en/site/
https://gdal.org/


 

 

Page 4 

https://en.wikipedia.org/wiki/Google_Earth 
 

Visualize / identify UTM zone in Google Earth Pro 
There are 120 (= 60 x 2) UTM zones and you need to know the corresponding zone ID of your 
target area. One of the easiest ways to find a zone ID is using Google Earth Pro.  

 
Menu: Tools > Options… > [3D View] tab > Show Lat/Long group box. Select “Universal 
Transverse Mercator” then zone IDs are visible on the screen canvas (and the toolbar). 
 

     
Google Earth Settings to show UTM zone (and MGRS)  

 

Find an EPSG code for the target UTM 
EPSG code is the ID that is used to identify the coordinate system and projection type. To 
reproject data to another system using GDAL, you will use an EPSG code. EPSG codes can be 
searched in QGIS - Menu: Project > Properties… > CRS tab. 

 

     
Find an EPSG code for the UTM zone 

https://en.wikipedia.org/wiki/Google_Earth
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Accessing GDAL command-line tools 
GDAL command-line tools come with QGIS installation, and they can be accessed via Windows 
Start menu > QGIS {version} > OSGeo4W Shell. Type any GDAL command, for example, 
 

gdalinfo --version 
 
to see if your installation is healthy. 
 
 

     
Accessing GDAL command-line tools via OSGeo4W Shell 

 

 
GDAL commands can be executed in the “OSGeo4W Shell” window 
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Placing GIS data in DWG at the right position w/ the right scale 

Preparation – make the data consumable first 
Before you place GIS data, check the projection/coordinate system of the data first. If it’s not 
properly projected, reproject it using the gdalwarp command. 

Check the coordinate system/projection 
Examine your GeoTIFF file using the gdalinfo command. For an Esri shape file (vector), 
ogrinfo command with “-al” option can be used. 
 
     gdalinfo       target-file.tif 
     ogrinfo  -al  target-file.shp 
 
If it’s already UTM projected, you can skip the rest of the following preparation section. 

 

Find the corresponding UTM zone ID 
Locate your target in Google Earth Pro. See the zone number and S / N designator. 

 

Find the corresponding EPSG code for the UTM zone ID 
Open QGIS > Project > Properties… > CRS tab, and search the UTM zone ID 
 

Reproject the data using EPSG code 
For a raster file (GeoTIFF file), open OSGeo4W Shell window then 
     gdalwarp -r cubic  -t_srs EPSG:{nnnnn}   input-file.tif    output-file.tif 
 
then “gdalinfo  output-file.tif ” to get the positions of the “lower-left” and “upper-right” 
corners of the generated image. We will use these X-Y coordinates when placing the file 
inside DWG 
 

 
Example: comer coordinates in gdalinfo output 

 
For a vector file (*.shp), type the following then open the generated DXF from AutoCAD. 
     ogr2ogr  -t_srs EPSG:{nnnn}  temp-file.shp   input-file 
     ogr2ogr  output-file.dxf   temp-file.shp 
 

Place GIS data inside DWG 

Raster files (GeoTIFF) 
Make sure your drawing unit is “meter.”  Then draw a rectangle using two coordinates 
you get from “gdalinfo” in the previous step. Place an image using that rectangle. 
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Using Digital Elevation Model (DEM) to DWG 

DEM (either Digital Surface Model – DSM, or Digital Terrain Model – DTM) can be placed into 
DWG since it usually comes in a raster file format (GeoTIFF), but simply placing it doesn’t much 
make sense. 
 

     
Left: DSM bitmap  /   Right: Hillside image (San Xavier Mine Site, AZ) 
from AW3D Enhanced 0.5m DSM credit  ©NTT DATA Corporation, Included © Maxar Technologies, Inc. 

 

Hillshade image 
You can generate a hillshade image, which is a more human-friendly form than a raw DEM 
raster, from DSM/DTM raster data.  

Generate hillshade image using a gdal tool 
Examine your GeoTIFF file using the gdalinfo command first to make sure your source 
data is properly projected (UTM or your preferred coordinate system). Then 
 
     gdaldem   hillshade    input-file.tif  output-file.tif 

 
Once you get a hillshade image, “gdalinfo output-file.tif” to get the lower-left & upper-right 
coordinates (X/Y), open a new drawing, set the drawing unit = meter, draw a rectangle using the 
Coordinates you got from gdalinfo command, then attach the image and make it fit the 
rectangle. 
 

Contour lines 
Another way to bring terrain elevation into an engineering drawing is to generate contour lines. 

Generating contour lines 
Examine your GeoTIFF file using the gdalinfo command first to make sure your source 
data is properly projected (UTM or your preferred coordinate system). Then try the 
following: 
 
     gdal_contour   -i  {interval}  -a ELEV  input-file.tif  output-file.shp 
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Example: (10m interval contour lines from c:\AU20\aaa.tif file) 
      gdal_contour  -i 10.00   -a  ELEV   c:\AU20\aaa.tif   c:\AU20\bbb.shp 
 
Thanks to the option “-a ELEV ”, the actual height (elevation) values are assigned to 
each line in the attribute table in the generated Esri shape file. To verify this, open the 
shape file from QGIS, select the layer, right-click mouse > select Open Attribute Table. 

 

          
“ELEV” column is created in the attribute table in the SHP file 

 

Convert an Esri Shape file to a DXF file 
Once you create contour lines in an Esri shape file format, you can convert it to a DXF 
file. The format should look something like: 
 
gr2ogr output-file.dxf name.shp -zfield ELEV -sql "SELECT ELEV Layer, * FROM name" 

 
“ELEV” is the column name in the attitude table in the shape file. “name” is the file name 
of the source Esri shape file (without file extension). Avoid using as special characters, 
symbols, or/and any non-plain-ASCII character that may confuse SQL syntax.  
Open the DXF file from AutoCAD, then you will see 3D contour lines are generated. 
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3D contour lines generated from a GeoTIFF file 

 

Massaging GIS data for Autodesk products  

From time to time, opening GIS data from your platform won’t work as you expected, because 
there are many sub-formats / dialects and you need to tweak before you use it. 
 

16-bit data type GeoTIFF 
As far as I have experienced, InfraWorks offers the most robust interoperability in terms of 
consuming GIS data. 

Example 
You can simply drag & drop DTM (Digital Terrain Model) in GeoTIFF format, Ortho-
imagery, and 3D building vector data as well. Within a few mouse clicks, you will be able 
to generate a photo-realistic 3D virtual city model. 
 

 
3D city model created in Autodesk InfraWorks (Minato City, Tokyo) 

AW3D DTM, Orhto-image,  & 3D building data, ©NTT DATA Corporation, Included © Maxar Technologies,Inc. 
 

The only issue I currently have with InfraWorks is that it won’t read 16-bit data type GeoTIFF 
correctly. When you take a look inside a GeoTIFF using the “gdalinfo” command, you will find 
that the data type of R/G/B band is UInt-16 (16-bit unsigned integer) in some satellite imageries. 
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This kind of 16-bit data type GeoTIFF is not shown correctly in AutoCAD either when it’s 
attached from a DWG. To fix this, you need to convert the data type from UInt-16 to Byte. This 
can be done using the gdal_translate command with “-ot Byte” option. 
 
 

 
“Type=UInt16” in gdalinfo command output 

 
When we convert a data type from UInt-16 to Byte, we need to know the proper scaling / 
stretching setting on each R/G/B band. We can refer to the auto-scaling settings in QGIS. Open 
a GeoTIFF file from QGIS, then right mouse button click on the layer, properties…, then open 
Symbology tab. You can copy & paste these min/max values. 
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QGIS Layer Properties > Symbology tab 

 
 
The command you will use should look something like this: 
 

gdal_translate -ot Byte -b 1 -b 2 -b 3 -scale_1 193 789 -scale_2 266 717 -scale_3 
319 682 -r cubic  input-file.tif   output-file.tif 

 
(this mimics the scaling/stretching settings you saw in the QGIS Symbology dialog.) 
 
 

64-bit offset GeoTIFF (BIG TIFF) 
When a satellite image cannot be opened from AutoCAD (but it can be opened from InfraWorks 
or GIS software), try to convert it to 32-bit GeoTIFF using gdal_translate command with -co 
option. The syntax should look like: 
 

gdal_translate -co BIGTIFF=NO  input-file.tif   output-file.tif 
 
If the size of the area is large and the resolution is fine, you may need to clip a TIFF. This can 
be done via QGIS menu: Raster > Extraction > Clip Raster by Mask Layer…  
 
 

Horizontal & vertical scale of a surface in Civil 3D 
This typically happens when you create a grid surface from a DEM but DEM is not properly 
projected. Find a suitable UTM zone number for your Area of Interest (AOI), get a 
corresponding EPSG code for the UTM zone, then reproject a GeoTIFF using that code before 
you create a grid surface. 
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Grid Surface from DEM (Talgar, Kazakhstan) 

DEM: KazEOSat-1 L-4 data / Courtesy Kazakhstan Gharysh Sapary (KGS ) 

 

Appendix: Online Resource  

Once you understand the concepts of what I demonstrated in this class, you should be able to 
find necessary information quite easily via your favorite online search service. 
The following are just some examples of where you should look into when they don’t appear at 
the top of your search results. 
 

Free GIS data 
Free data would be a good option when your financial constraint doesn’t allow you to use 
commercial data, even though you may have to compromise some aspects of the data quality, 
such as vintage, resolution, and/or accuracy. 
 

USGS 
You can find a wide range of GIS information and downloadable data including free high-
resolution DTM of the United States. Search “USGS National elevation Dataset (NED)” 
 https://www.usgs.gov/ 

 

AW3D30 
This is basically a downsampled version of commercial AW3D Standard DSM products 
(5m and 2.5m global coverage) + some additional treatments by JAXA (The Japan 
Aerospace Exploration Agency). It comes with a standard GeoTIFF file format, but you 
may need to add a no-data value definition to its metadata. Try: 
      gdal_translate -a_nodata -9999   input-file.tif   output-file.tif 

https://www.usgs.gov/
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There are several sites where you can download AW3D30, but please watch the version 
of the data (Ver 3.1 is the latest as of Nov/2020). 
 https://www.eorc.jaxa.jp/ALOS/en/aw3d30/index.htm 

 

SRTM 
SRTM is the most well-known and widely accepted global-scale DSM. It comes with 
*.hgt file format. You should be able to convert them into GeoTIFF file format using: 
    gdal_translate  input-file.hgt   output-file.tif 
It comes with a 1-degree x 1-degree tile in the geographic coordinate system (lat/long), 
so you may need to reproject the data into a suitable UTM zone. 
I usually use this wrapper site to locate my target tile. 
http://dwtkns.com/srtm30m/ 
 

GADM maps and data 
This is a great site to obtain vector GIS data, such as the country, state, county 
boundaries for non-commercial users. 
https://gadm.org/index.html 
 

 
 
 

Documentation / Information / Tutorial Video 
Here are some links I’d like to recommend to you. You will also find many tutorials that cover 
GIS-to-AutoCAD / AutoCAD-to-GIS workflows on YouTube and other online spaces. 
 

GDAL official documents 
There are many GDAL and OGR commands that you can massage GIS data to fit them 
for Autodesk products. I only scratch the surface of them in this class. Find a suitable 
command you need, then google it if it doesn’t work as you expected. 
https://gdal.org/index.html 
 

Generate good looking hillshade in QGIS 
If you need a good looking hillshade image with a proper color ramp for the background 
image of your project drawing, you can try the steps in this article. 
https://ieqgis.wordpress.com/2015/04/04/create-great-looking-topographic-maps-in-qgis-2/ 
 

Creating 3D contour lines and assign them to the corresponding layer 
This article explains the detailed usage of ogr2ogr when you convert contour lines in an 
Esri shape file to a DXF. 
https://gisforthought.com/gis-to-cad-using-ogr2ogr-part-1-shp-to-dxf-with-contour-data/ 
 

https://www.eorc.jaxa.jp/ALOS/en/aw3d30/index.htm
http://dwtkns.com/srtm30m/
https://gadm.org/index.html
https://gdal.org/index.html
https://ieqgis.wordpress.com/2015/04/04/create-great-looking-topographic-maps-in-qgis-2/
https://gisforthought.com/gis-to-cad-using-ogr2ogr-part-1-shp-to-dxf-with-contour-data/
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Importing GIS Data to AutoCAD Civil 3D 
This YouTube video explains how to use GIS data from Civil 3D / Map 3D in the way it 
should be. He is not using UTM in his example, but you will see that a local coordinate 
system just works just fine as long as it’s 2D drawing friendly. 
https://youtu.be/g7HW6apnh3g 
 

Adding Bing aerial image /Google satellite image to QGIS 
You can bring Bing aerial images, which are the same online image you get through 
AutoCAD GEOMAP command, into QGIS as well. Please refer to the settings of Tile 
Server (XYZ) settings in this article. 
https://gis.stackexchange.com/questions/20191/adding-basemaps-from-google-or-bing-in-qgis 

 

Zoom Earth (vintage info) 
You can find the vintage information (observation date) of the satellite image of the 
Bing/Esri online map/image. FYI - Bing aerial image is the one you see in the AutoCAD 
GEOMAP command. 
https://zoom.earth/ 
 

 
I hope this gives you some new ideas about using GIS data from Autodesk products. Do not 
hesitate to contact me (RESTEC) if you have any questions about the dataset I used in my 
demos, any workflow that doesn’t work for you, etc. 
Thank you! 
 

https://youtu.be/g7HW6apnh3g
https://gis.stackexchange.com/questions/20191/adding-basemaps-from-google-or-bing-in-qgis
https://zoom.earth/

